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Bab I 

Statistik Terapan untuk Pendidikan 

 

A. Pengantar Statistik Terapan 

Statistik dalam arti sempit dapat diartikan sebagai data, tetapi dalam 

arti luas statistik dapat diartikan sebagai alat. Alat untuk analisis dan alat 

untuk membuat keputusan. Statistik Terapan merupakan alat analisis 

dalam bentuk “Numerical Description” untuk menjelaskan setiap data 

yang diperoleh dari populasi dan sampel, untuk kemudian dilakukan 

perkiraan, peramalan, dan pengambilan keputusan. 

Statistika merupakan salah satu ilmu matematika yang sering 

digunakan dalam analisis data.  Statistik adalah alat pengolah kumpulan 

bahan keterangan (data), baik yang berwujud angka (data kuantitatif), 

maupun yang tidak berwujud angka (data kualitatif) yang mempunyai arti 

penting dan kegunaan yang besar dalam memberikan gambaran tentang 

suatu keadaan.  

Dengan demikian statistika adalah ilmu yang mempelajari statistik, 

yaitu ilmu yang mempelajari bagaimana caranya mengumpulkan data, 

menyederhanakan data, menyajikan data, dan membuat kesimpulan 

berdasarkan informasi yang diperoleh dari sampel. Fungsi utama 

statistika dalam pendidikan adalah di bidang penelitian, misalnya untuk 

melihat perkembangan peserta didik atau siswa, menilai kesesuaian 

materi bahan ajar dan kebutuhan di lapangan, dan mengetahui 

keberhasilan suatu lembaga pendidikan. 

Statistik Terapan menekankan pada bagaimana pengolahan data 

menggunakan SPSS, STATA, dan Software pengolahan data lainnya. 

Statistik Terapan yang biasa dilakukan oleh peneliti baik untuk dunia 

pendidikan maupun non pendidikan biasanya menggunakan SPSS. 

SPSS (Statistical Product And Service Solutions) merupakan suatu 

program komputer statistik yang mampu memproses data statistik secara 

cepat dan tepat, menjadi berbagai output yang dikhendaki para pengambil 

keputusan. Selanjutnya untuk mengetahu elemen statistiknya, pada 

terapannya dikenal dengan 2 pendekatan bagian dari statistik yaitu 

statistik deskriptif dan statistik inferensi. 

 

B. Pendekatan Statistik 

1. Statistik Deskriptif 

Statistik deskriptif adalah statistik yang tingkat pekerjaannya 

mencakup (a) menghimpun, (b) menyusun/mengatur, (c) mengolah, (d) 

menyajikan, dan (e) menganalisis data. Statistik deskriptif digunakan 



untuk memberikan gambaran yang jelas mengenai suatu keadaan. 

Statistik deskriptif secara umum digunakan untuk menggambarkan 

berbagai karakteristik data, seperti berapa rata-ratanya, seberapa jauh 

data-data bervariasi.  

2. Statistik Inferensi 

Statistik inferensial adalah statistik yang menyediakan cara yang 

dapat dipergunakan sebagai alat untuk mencoba menarik kesimpulan 

yang bersifat umum dari sekumpulan data yang telah disusun dan diolah. 

Statistik inferensial dalam penerapannya lebih luas dari pada statistik 

deskriptif mencakup (a) penarikan kesimpulan (conclusion), (b) 

penyusunan atau pembuatan dugaan (prediction), dan (c) penaksiran 

atau pendekatan (estimation). Dengan demikian untuk dapat memahami 

statistik infrerensial, peneliti harus lebih dahulu mempelajari statistik 

deskriptif. Statistik Inferensi atau induktif berusaha untuk membuat 

berbagai inferensi terhadap sekumpulan data yang berasal dari suatu 

sampel. Tindakan inferensi tersebut seperti melakukan perkiraan, 

peramalan, dan pengambilan keputusan. 

 

C. Data Penelitian 

Data penelitian dapat dikelompokkan menjadi data kualitatif dan data 

kuantitatif. Data kualitatif adalah data yang berbentuk kalimat, kata, atau 

gambar. Data kuantitatif adalah data yang berbentuk angka, atau data 

kualitatif yang diangkakan (skoring). Data kuantitatif dapat dikelompokan 

menjadi dua besar yaitu data diskrit dan data kontinum. Data diskrit 

adalah data yang diperoleh dari hasil menghitung atau membilang (bukan 

mengukur). Data diskrit sering juga disebut dengan data nominal. Data 

nominal biasanya diperoleh dari penelitian yang bersifat eksploratif atau 

survey. Data kontinum adalah data yang diperoleh dari hasil pengukuran. 

Data kontinum dapat dikelompokan menjadi tiga yaitu : (a) ordinal (data 

yang berjenjang atau berbentuk peringkat), (b) interval (data yang 

jaraknya sama, tetapi tidak mempunyai nilai nol absolut (mutlak), dan (c) 

rasio (data yang jaraknya sama dan mempunyai nilai nol absolut). 

 

D. Prosedur Pengujian  

Uji Hipotesis adalah metode pengambilan keputusan yang 

didasarkan dari analisa data, baik dari percobaan yang terkontrol, 

maupun dari observasi (tidak terkontrol). Dalam statistik, sebuah hasil 

pengujian dalam penelitian bisa dikatakan signifikan secara statistik jika 

kejadian tersebut hampir tidak mungkin disebabkan oleh faktor yang 



kebetulan, sesuai dengan batas probabilitas yang sudah ditentukan 

sebelumnya.  

Uji hipotesis disebut juga "konfirmasi analisa data". Keputusan 

dari uji hipotesis hampir selalu dibuat berdasarkan pengujian hipotesis 

nol. Ini adalah pengujian untuk menjawab pertanyaan yang 

mengasumsikan hipotesis nol adalah benar. Prosedur uji hipotesis 

dilakukan dengan cara sebagai berikut. 

1. Tentukan parameter yang akan diuji 

2. Tentukan Hipotesis nol (Ho) 

3. Tentukan Hipotesis alternatif (H1) 

4. Tentukan (α) 

5. Pilih statistik yang tepat 

6. Tentukan daerah penolakan 

7. Hitung statistik uji 

8. Putuskan apakah hipotesis nol (H0) ditolak atau tidak 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

BAB II 

UJI KOMPARASI 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



PRAKTIKUM 1. ONE SAMPLE T TEST 

 

A. Tujuan Praktikum 

Menguji perbedaan rata-rata suatu kelompok dengan suatu hipotesis 

atau atau kesamaan rata-rata suatu kelompok data dengan suatu rata-

rata tertentu dengan One Sample T Test.  

 

B. Masalah Penelitian Pendidikan 

1. Seorang guru ingin membandingkan nilai ujian IPA semua siswa 

kelas VII dengan rata-rata nilai ujian tahun yang lalu. Rata-rata ujian 

tahun lalu yaitu 6,5. Apakah nilai rata-rata tersebut berbeda 

signifikan dengan rata-rata 6,5 atau tidak? 

2. Seorang manajer pemasaran ingin membandingkan rata-rata 

penjualan salesman dengan rata-rata seorang sales yakni 

Bambang. Penjualan rata-rata Bambang 65 unit. Apakah rata-rata 

penjualan salesman berbeda signifikan dengan rata-rata penjualan 

sales Bambang sebesar 65 unit? 

 

C. Kasus 

Berikut ini disajikan data nilai UN mata pelajaran IPA kelas VIII.  

Nilai UN IPA 
Kelas VIII 

67 

58 

78 

63 

55 

71 

59 

65 

61 

78 

52 

Apakah nilai rata-rata UN IPA tahun ini berbeda signifikan dengan rata-

rata UN IPA tahun lalu? Diketahui rata-rata UN IPA tahun lalu adalah 

69. (Gunakan taraf signifikansi 5%) 

 

 

 

 



D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “UnIPA” di baris pertama dengan decimals 

bernilai 2.  

 
 

3. Pilih Data View di samping Variable View dan masukan data UN 

IPA. 

 
 

4. Pilih menu Analyze → Compare Mean → One Sample T Test. 

5. Masukan variabel UnIPA ke kotak Test Variable(s) dan isikan 69 di 

kotak Test Value. 



 
6. Klik tombol Option maka muncul kotak dialog One-Sample T Test : 

Option. Secara default Confidence Interval bernilai 95% dan 

Missing Values terpilih Exclude cases analysis by analysis yang 

berarti hanya data yang valid yang digunakan dalam analisis. 

 
 

7. Klik tombol Continue.  

8. Klik OK sehingga muncul hasil sebagai berikut. 

One-Sample Statistics 

 N Mean Std. Deviation Std. Error Mean 

UnIPA 11 64.2727 8.63818 2.60451 

 

One-Sample Test 

 

Test Value = 69 

t df 

Sig. (2-

tailed) 

Mean 

Difference 

95% Confidence Interval of the Difference 

Lower Upper 

UnIPA -1.815 10 .100 -4.72727 -10.5305 1.0759 

 

 

 

 



 

E. Pembacaan Hasil Analisis 

1. Tabel One-Sample Statistics menampilkan hasil analisis statistik 

deskriptif yang berisi data valid (N), nilai rata-rata, standar deviasi, 

dan standar error rata-rata. 

2. Tabel One-Sample Test menampilkan hasil analisis uji perbedaan 

rata-rata suatu kelompok dengan suatu hipotesis. 

Hipotesis Penelitian : 

Ho : rata-rata UN IPA tahun ini sama dengan tahun lalu. 

H1 : rata-rata UN IPA tahun ini tidak sama dengan tahun lalu. 

  

Ketentuan 

Jika t hitung < t table, maka Ho diterima. 
Jika t hitung > t table, maka Ho ditolak. 
Atau 
Jika Sig (2-tailed) > ½ α, maka Ho diterima. 
Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Nilai Sig (2-tailed = 0,100) > ½ α (0,025), maka Ho diterima. Jadi 

rata-rata UN IPA tahun ini sama dengan tahun lalu atau tidak ada 

perbedaan rata-rata nilai UN IPA tahun ini dengan tahun lalu secara 

signifikan. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang dilengkapi 

data (data fiktif tidak masalah) dan lakukan uji komparasi dengan One 

Sample T Test (gunakan taraf signifikansi 5% dengan data responden 

berjumlah minimal 30). 

 

  



PRAKTIKUM 2. INDEPENDENT T TEST 

 

A. Tujuan Praktikum 

Menguji signifikansi atau perbedaan rata dua kelompok yang saling 

bebas dengan Independent T Test. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah ada perbedaan rata-rata nilai ujian akhir semester mata 

pelajaran IPA  kelas VII antara siswa kelas A dan B? 

2. Apakah ada perbedaan nilai hasil belajar IPA antara  kelas 

pembelajaran inkuiri dengan pembelajaran ceramah? 

3. Apakah ada perbedaan hasil belajar antara pembelajaran berbasis 

media komputer dengan pembelajaran ceramah? 

4. Apakah ada perbedaan nilai antara peserta didik laki-laki dan 

wanita? 

 

C. Kasus 

Berikut ini disajikan data IPK mahasiswa kelas A yang (pembelajaran 

ceramah) dengan Kelas B (pembelajaran berbasis media komputer) 

dengan pembelajaran inkuiri. 

Nilai IPA 

Kelas A Kelas B 

3.12 3.29 

3.33 2.89 

3.40 3.48 

3.21 3.75 

2.98 3.33 

3.02 2.87 

3.66 3.27 

3.51 3.87 

 3.23 

 3.12 

 3.04 
 

Ujilah apakah kedua kelas memiliki varian yang sama? 

Ujilah apakah ada perbedaan IPK antara mahasiswa kelas A dan kelas 

B? Jika ada perbedaan, manakah yang memiliki IPK lebh tinggi?  

(Gunakan taraf signifikansi 5%) 

 

 



D. Prosedur Analisi 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Kelas” di baris pertama dengan decimals 

bernilai 0, dan “IPK” di baris ke dua dengan decimals bernilai 2.  

 
 

3. Pilih Data View di samping Variable View dan masukan data IPK  

dengan indeks 1 untuk kelas A dan indeks 2 untuk kelas B serta 

masukan semua nilainya. 

 



 
 

4. Pilih menu Analyze → Compare Mean → Independent-Samples 

T Test. 

5. Masukan variabel Nilai ke Test Variable(s) dan Kelas ke Grouping 

Variable. 



 
6. Klik tombol Define Groups dan isikan 1 di Group 1 dan 2 di Group 

2 dan klik tombol continue.  

 

 
7. Klik OK sehingga muncul hasil sebagai berikut. 

 



Output SPSS untuk Independent Samples T Test. 
 

 

Independent Samples Test 

 

Levene's Test for Equality of 

Variances t-test for Equality of Means 

F Sig. t df 

Sig. (2-

tailed) 

Mean 

Difference 

Std. Error 

Difference 

95% Confidence Interval of the 

Difference 

Lower Upper 

Nilai Equal variances assumed 2.835 .111 -5.845 17 .000 -.77670 .13288 -1.05705 -.49636 

Equal variances not assumed   -5.261 9.369 .000 -.77670 .14763 -1.10868 -.44473 

 

 

Group Statistics 

 
Kelas N Mean Std. Deviation Std. Error Mean 

Nilai 1 8 2.9788 .38632 .13658 

2 11 3.7555 .18587 .05604 



E. Pembacaan Hasil Analisis 

1. Tabel Group Statistics menampilkan hasil analisis statistik 

deskriptifnya seperti rata per kelompok, standar deviasi, dan 

standar error. 

Hasil analisis menunjukan : (a) jumlah data valid 19 (8 mahasiswa 

dengan pembelajaran ceramah dan 11 siswa dengan pembelajaran 

berbasis media komputer), (b) nilai rata-rata IPK kelas 

pembelajaran ceramah 2,98 dan nilai rata-rata kelas pembelajaran 

berbasis media computer 3,769, (c) standar deviasi masing-masing 

0,387 dan 0,186. 

2. Tabel Independent Samples Test menampilkan uji varian kedua 

kelompok dan perbedaan.  

F test digunakan untuk menguji asumsi dasar dari t test bahwa 

varian kedua kelompok sama. 

Hipotesis Penelitian : 

Ho : kedua kelompok memiliki varian yang sama (homogen). 

H1 : kedua kelompok memiliki varian yang tidak sama  (tidak 

homogen). 

Ketentuan 

Jika F hitung < F table, maka Ho diterima. 
Jika F hitung > F table, maka Ho ditolak. 
Atau 
Jika Sig > α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Nilai Sig (0,111) > α (0,05), maka Ho diterima. Jadi kedua kelompok 

memiliki varian yang sama  (homogen). 

 

Uji selanjutnya memakai nilai pada baris bagian atas (equal 

variances assumed), namun apabila pada perhitungan Sig < α maka 

memakai nilai baris yang bawah. 

Hipotesis Penelitian : 

Ho  : jenis pembelajaran tidak berpengaruh terhadap IPK 

mahasiswa. 

H1   :  jenis pembelajaran berpengaruh terhadap IPK mahasiswa. 

Ketentuan 

Jika t hitung < t table, maka Ho diterima. 
Jika t hitung > t table, maka Ho ditolak. 
Atau 
Jika Sig (2-tailed) > ½ α, maka Ho diterima. 
Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 
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Nilai t hitung kecil dan nilai Sig (2-tailed = 0,000) < ½ α (0,05) maka 

Ho ditolak. Jadi jenis pembelajaran yang digunakan dalam 

pembelajaran berpengaruh pada IPK mahasiswa. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan uji komparasi 

dengan Independent Samples Test (gunakan taraf signifikansi 5% 

dengan data responden berjumlah minimal 30). 
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Praktikum 3. Paired T Test 

  

 

A. Tujuan Praktikum 

Menguji perbedaan rata-rata dua kelompok yang saling berpasangan 

dengan Paired T Test. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah ada perbedaan nilai pre test dengan post test nilai ujian 

semester mata pelajaran IPA siswa kelas VIII? 

2. Apakah ada perbedaan skore IELT (kemampuan berbahasa 

Inggris) sebelum mengikuti kursus dan setelah kursus?  

 

C. Kasus 

Berikut ini disajikan data nilai pretest dan posttest dari siswa SMP kelas 

VIII mata pelajaran IPA. 

Nilai IPA 

Pre test 

Perlakuan 
(Pembelajaran 

Inkuiri) 

Post test 

45 78 

38 75 

47 80 

28 60 

37 64 

47 75 

44 79 

35 71 

41 67 

42 71 

  

 

Ujilah apakah ada perbedaan antara nilai pre test dan nilai post test? 

Jika ada perbedaan, manakah di antara keduanya yang nilainya lebih 

baik? (Gunakan taraf signifikansi 5%) 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “PreTest” di baris pertama dengan decimals 

bernilai 2, dan “PostTest” di baris ke dua dengan decimals bernilai 

2.  
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3. Pilih Data View dan masukan data pre test dan post test sebagai 

berikut.   

 
 

4. Pilih menu Analyze → Compare Mean → Paired-Samples T Test. 
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5. Masukan variabel PreTest dan PostTest ke kotak Paired Variables. 

 
 

6. Klik OK sehingga muncul hasil sebagai berikut. 
 



Output SPSS untuk Paired Samples T Test. 

Paired Samples Statistics 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 PreTest 40.4000 10 6.00370 1.89854 

PostTest 72.0000 10 6.68331 2.11345 

 

Paired Samples Correlations 

 N Correlation Sig. 

Pair 1 PreTest & PostTest 10 .817 .004 

 

Paired Samples Test 

 

Paired Differences 

t df Sig. (2-tailed) Mean Std. Deviation Std. Error Mean 

95% Confidence Interval of the 

Difference 

Lower Upper 

Pair 1 PreTest - PostTest -31.60000 3.89301 1.23108 -34.38489 -28.81511 -25.669 9 .000 



E. Pembacaan Hasil Analisis 

1. Tabel Paired Samples Statistics menampilkan nilai pre test (baris 

atas) dan post test (baris bawah) dengan parameter : rata-rata, 

jumlah sampel, standar deviasi, dan standar rata-rata error. 

2. Tabel Paired Samples Correlations menampilkan uji korelasi nilai 

pre test dan post test.  

Hipotesis Penelitian : 

Ho  :  Tidak ada hubungan antara pre test dan post test dengan 

pembelajaran inkuiri. 

H1  : Ada hubungan antara pre test dan post test dengan 

pembelajaran inkuiri. 

Ketentuan 
Jika Sig > α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Nilai Sig (0,004) < α (0,05), maka Ho ditolak. Jadi ada hubungan 

antara pre test dan post test dengan pembelajaran inkuiri dengan 

tingkat hubungan/korelasi cukup besar, yaitu 0,817. 

 

3. Tabel Paired Samples Test menampilkan uji beda nilai pre test dan 

post test sesudah perlakuan/pembelajaran inkuiri. 

Hipotesis Penelitian : 

Ho  :  Tidak ada perbedaan antara pre test dan post test dengan 

pembelajaran inkuiri. 

H1  : Ada perbedaan antara pre test dan post test dengan 

pembelajaran inkuiri. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 
Jika t hitung < t tabel, maka Ho diterima. 
Atau 
Jika Sig (2-tailed) > ½ α, maka Ho diterima. 
Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 

 

Nilai Sig (2-tailed = 0,000) < ½ α (0,025), maka Ho ditolak. Jadi 

ada perbedaan nilai pre test dan post test sesudah 

perlakuan/pembelajaran inkuiri. Dengan kata lain pembelajaran 

inkuiri berpengaruh terhadap hasil post test. 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan uji komparasi 

dan uji signifikansi/uji beda dengan Paired Samples Test (gunakan 

taraf signifikansi 5% dengan data responden berjumlah minimal 30). 



 

Praktikum 4. One Way Anova 

 

A. Tujuan Praktikum 

Menguji perbedaan rata-rata untuk lebih dari dua kelompok yang saling 

bebas dengan One Way Anova. Analisis One Way Anova merupakan 

analisis varian satu variabel independent yang digunakan untuk 

menentukan apakah rata-rata dua atau lebih kelompok berbeda secara 

nyata. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah ada perbedaan rata-rata nilai UN SMP mata pelajaran IPA 

siswa dari desa, pinggiran, dan kota? Manakah di antara ketiganya 

yang memiliki UN paling tinggi? 

2. Apakah ada perbedaan rata-rata skore TOEFL antara mahasiswa 

yang mengambil kursus bahasa Inggris tiga bulan, enam bulan, 

dan Sembilan bulan?  Manakah di antara ketiganya yang memiliki 

skore TOEFL paling tinggi? 

 

C. Kasus 

Berikut ini disajikan data skore TOEFL Mahasiswa Pendidikan IPA 

yang mengikuti kursus bahasa Inggris. 

Lama Kursus  
(Bulan) 

Skore TOEFL 

3 423 

3 410 

3 421 

3 428 

3 404 

6 444 

6 459 

6 440 

6 435 

6 468 

9 478 

9 480 

9 494 

9 507 

9 459 
 



 

Ujilah apakah ada perbedaan antara lama kursus terhadap skore 

TOEFL? (Gunakan taraf signifikansi 5%). 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “LamaKursus” di baris pertama dengan 

decimals bernilai 0, dan “SkoreToefl” di baris ke dua dengan 

decimals bernilai 2.  

 
3. Pilih Data View dan masukan data lama kursus dan skore Toefl 

sebagai berikut.   

 
 

4. Pilih menu Analyze → Compare Mean → One Way Anova. 



 

 
 

5. Masukan variabel SkoreToefl ke kotak Dependent List, dan 

LamaKursus ke kotak Faktor. 

 
 

6. Klik tombol Post Hoc → LSD → Continue. 

 



 

7. Klik tombol Options → Descriptive → Homogeneity of Variances 

Test → Continue. 

 
8. Klik OK sehingga muncul hasil sebagai berikut. 

 



Output SPSS untuk Paired Samples T Test. 
Descriptives 

SkoreToefl   

 N Mean Std. Deviation Std. Error 

95% Confidence Interval for Mean 

Minimum Maximum Lower Bound Upper Bound 

3 5 417.2000 9.88433 4.42041 404.9270 429.4730 404.00 428.00 
6 5 449.2000 13.80942 6.17576 432.0533 466.3467 435.00 468.00 
9 5 483.6000 18.06378 8.07837 461.1709 506.0291 459.00 507.00 
Total 15 450.0000 31.03684 8.01368 432.8124 467.1876 404.00 507.00 

 
Test of Homogeneity of Variances 

SkoreToefl   
Levene Statistic df1 df2 Sig. 

.786 2 12 .478 

 
ANOVA 

SkoreToefl   

 Sum of Squares df Mean Square F Sig. 

Between Groups 11027.200 2 5513.600 26.909 .000 
Within Groups 2458.800 12 204.900   
Total 13486.000 14    

 
Multiple Comparisons 

Dependent Variable:   SkoreToefl   
LSD   

(I) LamaKursus (J) LamaKursus 
Mean Difference 

(I-J) Std. Error Sig. 

95% Confidence Interval 

Lower Bound Upper Bound 

3 6 -32.00000* 9.05318 .004 -51.7252 -12.2748 

9 -66.40000* 9.05318 .000 -86.1252 -46.6748 

6 3 32.00000* 9.05318 .004 12.2748 51.7252 

9 -34.40000* 9.05318 .003 -54.1252 -14.6748 

9 3 66.40000* 9.05318 .000 46.6748 86.1252 

6 34.40000* 9.05318 .003 14.6748 54.1252 

*. The mean difference is significant at the 0.05 level. 



E. Pembacaan Hasil Analisis 

1. Tabel Descriptives menunjukan hasil analisis statistik deskriptifnya 

seperti rata per kelompok, standar deviasi, standar error, minimum 

dan maksimum. 

2. Tabel Test of Homogeneity of Variances menunjukan hasil uji 

homogenitas varians sebagai prasyarat untuk dapat menggunakan 

ANOVA. 

Hipotesis Penelitian : 

Ho :  Ketiga kelompok memiliki nilai varian yang sama. 

H1 : Ketiga kelompok memiliki nilai varian yang tidak sama. 

 

Ketentuan 
Jika Sig > α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Hasil pengujian ditemukan bahwa F hitung = 0,786 dengan sig = 

0,478. Oleh karena nilai sig > α (0,05) maka dapat disimpulkan 

bahwa ketiga kelompok memiliki nilai varian yang sama atau 

dengan kata lain varians antar kelompok bersifat homogen. Dengan 

demikian prasyarat untuk dapat menggunakan ANOVA terpenuhi. 

 

3. Tabel ANOVA menunjukan hasil uji beda rata-rata secara 

keseluruhan. 

Hipotesis Penelitian : 

Ho : Ketiga kelompok memiliki rata-rata skore Toefl yang sama. 

H1 : Ketiga kelompok memiliki rata-rata skore Toefl yang 

berbeda. 

Ketentuan 

Jika F hitung < F tabel, maka Ho diterima. 
Jika F hitung > F tabel, maka Ho ditolak. 
Atau  
Jika Sig > α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Hasil analisis ditemukan harga F hitung sebesar 26,909 dengan sig 

= 0,000. Oleh karena nilai sig < 0,05 maka Ho ditolak sehingga 

dapat disimpulkan ada perbedaan rata-rata skore Toefl antara 

mahasiswa yang mengambil kursus tiga bulan, enam bulan, dan 

Sembilan bulan.  

Keterangan : jika hasil pengujiannya signifikan maka dilanjutkan ke 

uji post hoc, tetapi jika tidak signifikan pengujian berhenti sampai di 

sini). 



 

4. Tabel Multiple Comparisons menunjukan hasil uji lanjut untuk 

mengetahui perbedaan antar kelompok secara spesifik sekaligus 

untuk mengetahui mana di antara ketiga kelompok tersebut yang 

skore Toeflnya paling tinggi. 

Hipotesis Penelitian : 

Ho : Kedua kelompok memiliki rata-rata skore Toefl yang sama. 

H1 : Kedua kelompok memiliki rata-rata skore Toefl yang tidak 

sama. 

Ketentuan 
Jika Sig > α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Misalnya untuk melihat perbedaan skore Toefl antara mahasiswa 

yang kursus tiga bulan dan enam bulan diperoleh nilai sig = 0,004, 

Oleh karena nilai sig < 0,05 dapat disimpulkan bahwa ada 

perbedaan skore Toefl antara mahasiswa yang kursus tiga bulan 

dan enam bulan. Dalam hal ini skore Toefl mahasiswa yang kursus 

enam bulan lebih tinggi dari pada yang kursus tiga bulan. Dengan 

kata lain lama kursus berpengaruh terhadap peningkatan skore 

Toefl mahasiswa. 

5. Anda juga dapat membandingkan analisis khusus untuk kelompok 

tertentu saja. Misalnya apakah ada perbedaan skore rata-rata Toefl 

untuk kursus enam bulan dan Sembilan bulan. Berikut langkah-

langkahnya. 

a. Pilih menu Analyze → Compare Mean → One Way Anova. 

b. Pilih Contras sehingga muncul kotak dialog One Way Anova : 

Contrast. 

 



 

c. Masukan nilai 0 pada kolom Coefficient untuk pembobot 

kelompok pertama kemudian klik Add. Kelompok kedua dan 

ketiga yang akan dibandingkan diberi pembobot di mana nilai 

total adalah nol, misalnya -1 dan 1. 

 
d. Klik Continue. 

e. Klik OK muncul hasil analisis sebagai berikut. 

 

 



Output SPSS untuk analisis One-Way Anova : Contrast. 
 

Contrast Coefficients 

Contrast 

LamaKursus 

3 6 9 

1 0 -1 1 

 
Contrast Tests 

  Contrast Value of Contrast Std. Error t df Sig. (2-tailed) 

SkoreToefl Assume equal variances 1 34.4000 9.05318 3.800 12 .003 

Does not assume equal 
variances 

1 
34.4000 10.16858 3.383 7.485 .011 



Keterangan. 

Hipotesis Penelitian : 

Ho : Kedua kelompok memiliki rata-rata skore Toefl yang 

sama. 

H1 : Kedua kelompok memiliki rata-rata skore Toefl yang 

tidak sama. 

Ketentuan 

Jika Sig (2-tailed) > ½ α, maka Ho diterima. 
Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 
Atau 
Jika t hitung < t tabel, maka Ho diterima. 
Jika t hitung > t tabel, maka Ho ditolak. 
 

 

Pada table Contrast pilih Assume equal variances karena sesuai 

dengan uji terdahulu. Nilai Sig (2-tailed = 0,003) < ½ α (0,025) 

maka Ho di tolak. Jadi kedua kelompok (kelompok yang kursus 

enam bulan dan kelompok yang kursus Sembilan bulan) memiliki 

rata-rata skore Toefl yang berbeda. 



F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan uji komparasi 

dengan One-Way Anova (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 

 

 

  



 

 

 

  

 

 

 

 

BAB III. 

UJI KORELASI 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Praktikum 4. Korelasi Product Moment 

 

A. Tujuan Praktikum 

Menguji korelasi/hubungan antara satu variabel dengan satu variabel 

lainnya dengan Korelasi Product Moment. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah ada korelasi yang positif antara kemampuan fisika 

matematika dengan prestasi belajar fisika  kuantum mahasiswa 

fisika FMIPA UNY? 

2. Apakah ada hubungan antara pengalaman kerja dengan 

produktivitas kerja karyawan? 

 

C. Kasus 

Berikut disajikan data nilai fisika matematika dan prestasi fisika 

mahasiswa fisika FMIPA UNY. 

Fisika Matematika Fisika Kuantum 

45 57 

35 43 

50 62 

40 53 

31 44 

28 40 

58 69 

60 73 

68 79 

75 83 
 

Ujilah apakah ada korelasi yang positif antara kemampuan Fisika 

Matematika dengan prestasi belajar Fisika Kuantum? (Gunakan taraf 

signifikansi 5%). 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “FisikaMatematika” di baris pertama dengan 

decimals bernilai 2, dan “FisikaKuantum” di baris ke dua dengan 

decimals bernilai 2.  



 

 
3. Pilih Data View dan masukan nilai Fisika Matematika dan Fisika 

Kuantum sebagai berikut.   

 
 

4. Pilih menu Analyze → Correlate → Bivariate. 

5. Masukkan variabel FisikaMatematika dan FisikaKuantum ke kotak 

Variables sehingga akan terlihat seperti berikut. 



 

 
 

6. Klik tombol Options → Means and Standard Deviation → Cross 

Product Deviations and Covariance → Continue. 

7. Klik OK sehingga akan muncul hasil analisis. 

Descriptive Statistics 

 Mean Std. Deviation N 

FisikaMatematika 49.0000 15.97915 10 

FisikaKuantum 60.3000 15.44201 10 

 

Correlations 

 FisikaMatematika FisikaKuantum 

FisikaMatematika Pearson Correlation 1 .993** 

Sig. (2-tailed)  .000 

Sum of Squares and Cross-

products 
2298.000 2206.000 

Covariance 255.333 245.111 

N 10 10 

FisikaKuantum Pearson Correlation .993** 1 

Sig. (2-tailed) .000  

Sum of Squares and Cross-

products 
2206.000 2146.100 

Covariance 245.111 238.456 

N 10 10 

**. Correlation is significant at the 0.01 level (2-tailed). 

 



 

E. Pembacaan Hasil Analisis 

1. Tabel Descriptive Statistics menampilkan hasil analisis statistik 

deskriptifnya seperti rata-rata per variabel, standar deviasi, dan 

jumlah sampel. 

2. Tabel Correlations, ada dua tanda dalam penafsiran korelasi 

melalui nilai koefisien, yaitu tanda (+) dan (-) yang berhubungan 

dengan arah korelasi, serta menyatakan kuat tidaknya korelasi.  

Hipotesis Penelitian : 

Ho : Tidak ada hubungan (korelasi) antara dua variabel. 

H1 : Ada hubungan (korelasi) antara dua variabel. 

Ketentuan 

Jika Sig (2-tailed) > ½ α, maka Ho diterima. 
Jika Sig (2-tailed) < ½ α, maka Ho ditolak. 
Atau 
Jika t hitung < t tabel, maka Ho diterima. 
Jika t hitung > t tabel, maka Ho ditolak. 

 

Pada tabel Correlations nilai Sig (2-tailed = 0,000) < ½ α (0,025) 

maka Ho di tolak. Jadi ada korelasi positif kemampuan fisika 

matematika dengan prestasi fisika kuantum semakin tinggi 

kemampuan fisika matematika semakin tinggi prestasi fisika 

kuantum. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan uji korelasi 

product moment (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 

 

  



 

Praktikum 6. Regresi Linear Sederhana 

 

A. Tujuan Praktikum 

1. Menguji hubungan/korelasi/pengaruh satu variabel bebas terhadap 

satu variabel terikat dengan menggunakan analisis regresi linier 

sederhana. 

2. Melakukan prediksi atau estimasi variabel terikat berdasarkan 

variabel bebasnya dengan menggunakan analisis regresi linier 

sederhana. 

Keterangan : data yang dianalisis harus berupa data yang  berskala 

interval/rasio. 

 

B. Contoh Masalah 

1. Apakah ada pengaruh antara kemampuan fisika matematika 

terhadap prestasi belajar fisika  kuantum mahasiswa fisika FMIPA 

UNY? 

2. Apakah ada pengaruh antara pengalaman kerja terhadap 

produktivitas kerja karyawan? 

 

C. Kasus 

Berikut disajikan data nilai fisika matematika dan prestasi fisika 

mahasiswa fisika FMIPA UNY. 

Fisika Matematika Fisika Kuantum 

45 57 

35 43 

50 62 

40 53 

31 44 

28 40 

58 69 

60 73 

68 79 

75 83 

 

1. Ujilah apakah ada pengaruh motivasi belajar terhadap prestasi 

belajar? (Gunakan taraf signifikansi 5%). 

2. Hitunglah berapa besarnya kontribusi variabel bebas terhadap 

variabel terikatnya? 

3. Bagaimana persamaan garis regresinya? 

 



 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “FisikaMatematika” di baris pertama dengan 

decimals bernilai 2, dan “FisikaKuantum” di baris ke dua dengan 

decimals bernilai 2.  

 
3. Pilih Data View dan masukan nilai Fisika Matematika dan Fisika 

Kuantum sebagai berikut.   

 
4. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

5. Masukan variabel FisikaKuantum ke kotak dependent (sebagai 

Variabel Dependent) dan FisikaMatematika ke kotak independent 

(sebagai Variabel Independent). 



 

 
6. Klik OK sehingga akan muncul hasil analisis. 

Variables Entered/Removeda 

Model Variables Entered 

Variables 

Removed Method 

1 FisikaMatematikab . Enter 

a. Dependent Variable: FisikaKuantum 

b. All requested variables entered. 

 

Model Summary 

Model R R Square Adjusted R Square Std. Error of the Estimate 

1 .993a .987 .985 1.88470 

a. Predictors: (Constant), FisikaMatematika 

 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 2117.683 1 2117.683 596.178 .000b 

Residual 28.417 8 3.552   

Total 2146.100 9    

a. Dependent Variable: FisikaKuantum 

b. Predictors: (Constant), FisikaMatematika 

 

Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 



 

1 (Constant) 13.262 2.017  6.576 .000 

FisikaMatematika .960 .039 .993 24.417 .000 

a. Dependent Variable: FisikaKuantum 

 

E. Pembacaan Hasil Analisis 

1. Tabel Variables Entered/Removeda  menampilkan variabel yang 

dimasukkan dalam model, dikeluarkan, metode analisisnya. Dalam 

hal ini variabel yang dimasukkan ke dalam model adalah Fisika 

Matematika, variabel yang dikeluarkan tidak ada dan metode 

analisis yang digunakan adalah metode enter (dimasukkan secara 

simultan/bersama). 

2. Tabel Model Summary menampilkan nilai R yang merupakan 

simbol dari nilai koefisien korelasi. Pada contoh diatas nilai korelasi 

adalah 0,993. Melalui tabel ini juga diperoleh nilai R Square atau 

koefisien determinasi (KD) yang menunjukkan seberapa bagus 

model regresi yang dibentuk oleh interaksi variabel bebas dan 

variabel terikat. Nilai KD yang diperoleh adalah 98,7% yang dapat 

ditafsirkan bahwa variabel bebas Fisika Matematika memiliki 

pengaruh kontribusi yang sangat besar yaitu  98,7 % terhadap 

variabel Fisika Kuantum dan 1,3 % lainnya dipengaruhi oleh faktor-

faktor lain diluar variabel Fisika Matematika. 

3. Tabel ANOVAa digunakan untuk menentukan taraf signifikansi atau 

linieritas dari regresi.  

Hipotesis Penelitian : 

Ho : Tidak terjadi hubungan linier antara kemampuan Fisika 

Matematika terhadap prestasi Fisika Kuantum. 

H1 : Terjadi hubungan linier antara kemampuan Fisika 

Matematika terhadap prestasi Fisika Kuantum. 

Ketentuan 

Jika F hitung > F tabel, maka Ho ditolak. 
Jika F hitung < F tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel ketiga, diperoleh nilai Sig (0,00) < α (0,05), 

dengan demikian Ho ditolak. Dengan demikian ada hubungan linier 

antara kemampuan Fisika Matematika terhadap prestasi Fisika 

Kuantum. 

4. Tabel Coefficientsa menginformasikan uji Coefficient dan uji 

konstanta.  



 

Hipotesis Penelitian (uji koefisien) : 

Ho : koefisien Fisika Matematika tidak signifikan. 

H1 : koefisien Fisika Matematika signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 
Jika t hitung < t tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel keempat (baris FisikaMatematika), diperoleh 

nilai t hitung =  24.417 dan Sig =0,00. Nilai sig < α (0,05), dengan 

demikian Ho ditolak. Dengan demikian koefisien kemampuan Fisika 

Matematika terhadap prestasi Fisika Kuantum signifikan. 

 

Hipotesis Penelitian (uji konstanta) : 

Ho : konstanta tidak signifikan. 

H1 : konstanta signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 
Jika t hitung < t tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel keempat (baris Constant), diperoleh nilai t = 

6,576 dan Sig = 0,00. Nilai sig (0,00) < α (0,05), dengan demikian 

Ho ditolak. Dengan demikian koefisien kemampuan Fisika 

Matematika terhadap prestasi Fisika Kuantum signifikan. 

Model persamaan regresi diperoleh dari koefisien konstanta dan 

koefisien variabel yang ada di kolom Unstandardized Coefficients 

B. Berdasarkan tabel ini diperoleh model persamaan regresi : 

Fisika Kuantum (Y) =13,262 + 0,960 x Fisika Matematika (X) atau 

Y = 13,262 + 0,960 X. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan Analisis Regresi 

Linier Sederhana (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 

  



 

Praktikum 7. Regresi Linear Ganda 

 

A. Tujuan Praktikum 

1. Menguji hubungan/korelasi/pengaruh lebih dari satu variabel 

bebas terhadap satu variabel terikat dengan analisis regresi linier 

ganda. 

2. Melakukan prediksi atau estimasi variabel terikat berdasarkan 

variabel bebasnya. 

Data yang dianalisis harus berupa data yang berskala interval/rasio. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah ada pengaruh fasilitas belajar dan motivasi belajar terhadap 

prestasi belajar mahasiswa? 

2. Bagaimana pengaruh lingkungan kerja dan pengalaman kerja 

terhadap produktivitas kerja karyawan? 

3. Apakah ada pengaruh gaji perbulan dan fasilitas kantor terhadap 

kinerja pegawai? 

 

C. Kasus 

Berikut disajikan data fasilitas belajar dan motivasi belajar terhadap 

prestasi belajar mahasiswa. 

Fasilitas 
Belajar 

Motivasi 
Belajar 

Prestasi 
Belajar 

10 8 89 

8 6 85 

6 6 78 

6 4 74 

4 6 69 

4 10 70 

8 10 85 

6 8 71 

10 12 92 

2 6 56 

4 4 67 

4 4 66 

6 9 78 

10 9 90 
 

1. Hitunglah berapa besarnya kontribusi bersama seluruh variabel 

bebas terhadap variabel terikatnya? 



 

2. Ujilah apakah ada kontribusi tersebut signifikan? (Gunakan taraf 

signifikansi 5%) 

3. Bagaimana persamaan garis regresinya? Tafsirkan maknanya! 

4. Ujilah pengaruh secara masing-masing variabel bebas secara 

parsial! 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Fasilitas” di baris pertama dengan decimals 

bernilai 2, “Motivasi” di baris ke dua dengan decimals bernilai 2, dan 

Prestasi di baris ke tiga dengan decimals bernilai 2.  

 
3. Pilih Data View dan masukan nilai fasilitas belajar, motivasi belajar, 

dan prestasi sebagai berikut.   



 

 
4. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

5. Masukkan variabel Prestasi ke kotak Dependent dan variabel 

Fasilitas dan Motivasi ke dalam kotak Independent(s) sehingga 

akan terlihat seperti berikut. 



 

 
6. Klik Ok sehingga muncul hasil analisis sebagai berikut. 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Motivasi, 

Fasilitasb 
. Enter 

a. Dependent Variable: Prestasi 

b. All requested variables entered. 

 

Model Summary 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .978a .956 .948 2.44123 

a. Predictors: (Constant), Motivasi, Fasilitas 

 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1417.873 2 708.936 118.957 .000b 

Residual 65.556 11 5.960   

Total 1483.429 13    

a. Dependent Variable: Prestasi 

b. Predictors: (Constant), Motivasi, Fasilitas 

 

Coefficientsa 

Model Unstandardized Coefficients 

Standardized 

Coefficients t Sig. 



 

B Std. Error Beta 

1 (Constant) 49.908 2.169  23.004 .000 

Fasilitas 3.871 .314 .937 12.318 .000 

Motivasi .301 .322 .071 .935 .370 

a. Dependent Variable: Prestasi 

 

E. Pembacaan Hasil Analisis 

1. Tabel Variables Entered/Removeda  menampilkan variabel yang 

dimasukkan dalam model, dikeluarkan, metode analisisnya. Dalam 

hal ini variabel yang dimasukkan ke dalam model adalah Motivasi 

dan Fasilitas, variabel yang dikeluarkan tidak ada dan metode 

analisis yang digunakan adalah metode enter (dimasukkan secara 

simultan/bersama). Di bagian bawah juga ditampilkan nama 

variabel terikatnya yaitu Prestasi (Dependent Variable: Prestasi). 

2. Tabel Model Summary menunjukan beberapa hal sebagai 

berikut. 

a. R = 0,978 artinya koefisien korelasinya sebesar 0,978. Angka ini 

menunjukkan derajad korelasi antara variabel fasilitas belajar 

dan motivasi belajar dengan prestasi belajar. 

b. R Square = 0,956 menunjukkan angka koefisien determinasinya 

(R2). Artinya variansi dalam prestasi dapat dijelaskan oleh fasilias 

belajar dan motivasi belajar melalui model sebesar 95,6 %, 

sisanya (3,4%) berasal dari variabel lain. Atau dengan bahasa 

sederhana besarnya kontribusi/sumbangan fasilias belajar dan 

motivasi belajar terhadap prestasi belajar adalah sebesar 95,6 

%, sisanya 3,4 % berasal dari variabel lain. 

c. Adjusted R square = 0,948. Ukuran ini maknanya sama dengan 

R square,hanya saja Adjusted R square ini nilainya lebih stabil 

karena sudah disesuaikan dengan jumlah variabel bebasnya. 

d. Standard Error of The Estimate = 2,44123 yang menunjukkan 

ukuran tingkat kesalahan dalam melakukan prediksi terhadap 

variabel terikat. 

3. Tabel ANOVAa digunakan untuk menentukan taraf signifikansi atau 

linieritas dari regresi.  

Hipotesis Penelitian (uji kelinieran) : 

Ho : Tidak terjadi hubungan linier antara variabel predictor 

(fasilitas belajar dan motivasi belajar) dengan variabel 

dependen (prestasi belajar). 



 

H1 : Terjadi hubungan linier antara variabel predictor (fasilitas 

belajar dan motivasi belajar) dengan variabel dependen 

(prestasi belajar). 

Ketentuan 

Jika F hitung > F tabel, maka Ho ditolak. 
Jika F hitung < F tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel ketiga, diperoleh nilai Sig (0,00) < α (0,05), 

dengan demikian Ho ditolak. Dengan demikian ada hubungan linier 

antara variabel predictor (fasilitas belajar dan motivasi belajar) 

dengan variabel dependen (prestasi belajar). 

4. Tabel Coefficientsa menginformasikan uji Coefficient dan uji 

konstanta.  

Hipotesis Penelitian (uji koefisien fasilitas belajar) : 

Ho : koefisien fasilitas belajar tidak signifikan. 

H1 : koefisien fasilitas belajar signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 
Jika t hitung < t tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel keempat (baris Fasilitas), diperoleh nilai t hitung 

=  12,318 dan Sig = 0,00. Nilai sig (0,00) < α (0,05), dengan demikian 

Ho ditolak. Dengan demikian koefisien fasilitas belajar signifikan. 

 

Hipotesis Penelitian (uji koefisien motivasi belajar) : 

Ho : koefisien motivasi belajar tidak signifikan. 

H1 : koefisien motivasi belajar signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho ditolak. 
Jika t hitung < t tabel, maka Ho diterima. 
Atau  
Jika Sig < α, maka Ho ditolak. 
Jika Sig > α, maka Ho diterima. 

 

Berdasarkan tabel keempat (baris Motivasi), diperoleh nilai t hitung 

=  0,935 dan Sig = 0,370. Nilai sig (0,370) > α (0,05), dengan demikian 

Ho diterima. Dengan demikian koefisien motivasi belajar tidak 

signifikan. 



 

 

Hipotesis Penelitian (uji konstanta) : 

Ho : konstanta tidak signifikan. 

H1 : konstanta signifikan. 

Ketentuan 

Jika t hitung > t tabel, maka Ho diterima. 
Jika t hitung < t tabel, maka Ho ditolak. 
Atau  
Jika Sig < α, maka Ho diterima. 
Jika Sig > α, maka Ho ditolak. 

 

Berdasarkan tabel keempat (baris Constant), diperoleh nilai t = 

23,004 dan Sig = 0,00. Nilai sig (0,00) < α (0,05), dengan demikian 

Ho diterima. Dengan demikian konstanta tidak signifikan. 

 

Model persamaan regresi diperoleh dari koefisien konstanta dan 

koefisien variabel yang ada di kolom Unstandardized Coefficients 

B. Berdasarkan tabel ini diperoleh model persamaan regresi : 

Prestasi (Y) = 49,908 + 3,871 x Fasilitas Belajar (X1) + 0,301 x 

Motivasi Belajar (X2) atau Y =.49,908 + 3,871 (X1) + 0,301 (X2). 

. 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan Analisis Regresi 

Linier Ganda (gunakan taraf signifikansi 5% dengan data responden 

berjumlah minimal 30). 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

BAB IV.  

UJI PRASYARAT ANALISIS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Praktikum 8. Uji Normalitas 

 

A. Tujuan Praktikum 

Mengetahui distribusi data, apakah berbentuk distribusi normal atau 

tidak dengan analisis uji normalitas atau 1 Sample K-S. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah data pre test mata pelajaran IPA berdistribusi normal? 

2. Apakah data post test mata pelajaran IPA berdistribusi normal? 

 

C. Kasus 

Berikut ini disajikan data tentang pre test, motivasi belajar, dan post 

test hasil belajar IPA SMP kelas VII. 

Motivasi 
Belajar 

Pre Test Post Test 

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 



 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Ujilah apakah ketiga variabel di atas memiliki distribusi normal? Ujilah 

dengan menggunakan taraf signifikansi 5%! 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” di baris pertama dengan decimals 

bernilai 2, “PresTest” di baris ke dua dengan decimals bernilai 2, 

dan PostTest di baris ke tiga dengan decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, pre test, dan 

post test sebagai berikut. 



 

 
 

4. Lakukan analisis dengan menggunakan menu Analyze → Legacy 

Dialogs → 1 Sample K-S. Masukan semua variabel ke kotak Test 

Variable List. 

 
 

5. Klik OK sehingga muncul hasil analisis sebagai berikut. 



 

One-Sample Kolmogorov-Smirnov Test 

 Motivasi PresTest PostTest 

N 30 30 30 

Normal Parametersa,b Mean 63.9000 21.6000 70.8333 

Std. Deviation 8.39684 4.77493 8.22982 

Most Extreme Differences Absolute .135 .200 .274 

Positive .135 .200 .274 

Negative -.087 -.125 -.139 

Test Statistic .135 .200 .274 

Asymp. Sig. (2-tailed) .174c .004c .000c 

a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 

 

E. Pembacaan Hasil Analisis 

Tabel One-Sample Kolmogorov-Smirnov Test menunjukkan hasil 

analisis uji normalitas terhadap ketiga variabel tersebut.  

Hipotesis Penelitian : 

Ho  : Sampel berdistribusi normal. 

H1  : Sampel berdistribusi tidak normal. 

 

Ketentuan 
Jika Asymp. Sig (2-tailed) ≥ α, maka Ho diterima. 
Jika Asymp. Sig (2-tailed) < α, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas diperoleh :  

1. Motivasi dengan Asymp. Sig (2-tailed = 0,174) ≥ α (0,05) sehingga 

berdistribusi normal. 

2. Pre Test dengan Asymp. Sig (2-tailed = 0,004) < α (0,05) sehingga 

berdistribusi tidak normal. 

3. Post Test dengan Asymp. Sig (2-tailed = 0,000) < α (0,05) sehingga 

berdistribusi tidak normal. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan Analisis 

Distribusi Normal untuk mengetahu berdistribusi normal atau tidak 

(gunakan taraf signifikansi 5% dengan data responden berjumlah 

minimal 30). 

  



 

Praktikum 9. Uji Linearitas 

 

A. Tujuan Praktikum 

Mengetahui hubungan antara variabel bebas dengan variabel terikat 

dengan uji linearitas. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah hubungan antara variabel motivasi belajar dengan variabel 

prestasi belajar berbentuk garis linear? 

2. Apakah hubungan antara variabel kemampuan awal dengan 

variabel prestasi belajar berbentuk garis linear? 

 

C. Kasus 

Berikut ini disajikan data motivasi belajar, kemampuan awal, dan 

prestasi belajar IPA SMP kelas VIII. 

Motivasi 
Belajar 

Kemampuan 
Awal 

Prsetasi 
Belajar 

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 

63 24 68 



 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Berdasarkan data di atas ujilah : 

1. apakah hubungan antara variabel motivasi belajar dengan variabel 

prestasi belajar berbentuk garis linear? 

2. apakah hubungan antara variabel kemampuan awal dengan 

variabel prestasi belajar berbentuk garis linear? 

Gunakan taraf signifikansi 5 %. 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” untuk variabel motivasi belajar di 

baris pertama dengan decimals bernilai 2, “Awal” untuk variabel 

kemampuan awal di baris ke dua dengan decimals bernilai 2, dan 

“Akhir” untuk variabel prestasi belajar di baris ke tiga dengan 

decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, kemampuan 

awal, dan kemampuan akhir sebagai berikut. 



 

 
 

4. Lakukan analisis dengan menggunakan menu Analyze → 

Compare Means → Means. 

5. Masukkan seluruh variabel bebas (Motivasi dan Awal) ke dalam 

kotak Independent List dan masukkan variabel terikatnya (Prestasi) 

pada kotak Dependent List. 

6. Klik tombol Option → klik Test for linearity → klik Continue. 



 

 
7. Klik OK sehingga akan muncul hasil analisis sebagai berikut. 

 



Means 

 Case Processing Summary 

 

Cases 

Included Excluded Total 

N Percent N Percent N Percent 

Akhir  * Motivasi 30 100.0% 0 0.0% 30 100.0% 

Akhir  * Awal 30 100.0% 0 0.0% 30 100.0% 

 

Akhir-Motivasi 

Report 

Akhir   

Motivasi Mean N Std. Deviation 

50.00 66.0000 1 . 

52.00 67.0000 1 . 

55.00 68.0000 1 . 

56.00 64.5000 2 .70711 

57.00 68.5000 2 2.12132 

58.00 66.5000 2 2.12132 

59.00 66.5000 2 2.12132 

60.00 69.5000 2 .70711 

61.00 60.0000 1 . 

63.00 69.5000 2 2.12132 

64.00 69.5000 2 .70711 

65.00 62.0000 2 8.48528 

66.00 70.0000 2 .00000 

68.00 78.0000 1 . 

69.00 76.0000 1 . 



 

73.00 72.0000 1 . 

74.00 70.0000 1 . 

78.00 89.0000 1 . 

79.00 90.0000 1 . 

80.00 90.0000 1 . 

82.00 86.0000 1 . 

Total 70.8333 30 8.22982 

 

Anova Table 

ANOVA Table 

 Sum of Squares df Mean Square F Sig. 

Akhir * Motivasi Between Groups (Combined) 1872.667 20 93.633 9.210 .001 

Linearity 1207.812 1 1207.812 118.801 .000 

Deviation from Linearity 664.855 19 34.992 3.442 .031 

Within Groups 91.500 9 10.167   

Total 1964.167 29    

 

Measures of Association 

 R R Squared Eta Eta Squared 

Akhir * Motivasi .784 .615 .976 .953 

 

 

 

 

 

 



 

Akhir-Awal 

Report 

Akhir   

Awal Mean N Std. Deviation 

15.00 65.0000 1 . 

16.00 70.0000 1 . 

17.00 66.0000 1 . 

18.00 66.8333 6 1.47196 

19.00 65.3333 3 4.72582 

20.00 68.0000 4 2.82843 

21.00 73.0000 2 4.24264 

22.00 68.5000 4 9.18332 

23.00 72.0000 1 . 

24.00 68.0000 1 . 

25.00 70.0000 1 . 

26.00 70.0000 1 . 

30.00 89.0000 1 . 

32.00 88.0000 2 2.82843 

33.00 90.0000 1 . 

Total 70.8333 30 8.22982 

 

 

 

 

 

 

 

 



 

ANOVA Table 

 Sum of Squares df Mean Square F Sig. 

Akhir * Awal Between Groups (Combined) 1605.667 14 114.690 4.799 .002 

Linearity 1288.459 1 1288.459 53.910 .000 

Deviation from Linearity 317.208 13 24.401 1.021 .480 

Within Groups 358.500 15 23.900   

Total 1964.167 29    

 

Measures of Association 

 R R Squared Eta Eta Squared 

Akhir * Awal .810 .656 .904 .817 



E. Pembacaan Hasil Analisis 

1. Tabel ANOVA Table untuk Akhir*Motivasi. 

Hipotesis Penelitian : 

Ho : Hubungan variabel motivasi belajar terhadap prestasi 

belajar bersifat linier. 

H1 : Hubungan variabel motivasi belajar terhadap prestasi 

belajar tidak bersifat linier. 

Ketentuan 

Yang perlu dilihat adalah hasil uji F untuk baris 
Deviation from linearity. 
Jika Sig ≥ α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas diperoleh nilai Sig (0, 0,031) < α 

(0,05) sehingga Ho di tolak. Dengan demikian hubungan variabel 

motivasi belajar terhadap prestasi belajar tidak bersifat linier. 
 

2. Tabel ANOVA Table untuk Akhir*Awal. 

Hipotesis Penelitian : 

Ho : Hubungan variabel motivasi belajar terhadap prestasi 

belajar bersifat linier. 

H1 : Hubungan variabel motivasi belajar terhadap prestasi 

belajar tidak bersifat linier. 

Ketentuan 

Yang perlu dilihat adalah hasil uji F untuk baris 
Deviation from linearity. 
Jika Sig ≥ α, maka Ho diterima. 
Jika Sig < α, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas diperoleh nilai Sig (0,480) ≥ α 

(0,05) sehingga Ho di terima. Dengan demikian hungan variabel 

kemampuan awal terhadap prestasi belajar bersifat linier. 

 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang dilengkapi 

data (data fiktif tidak masalah) dan lakukan Analisis Linieritas untuk 

mengetahu bersifat linier atau tidak (gunakan taraf signifikansi 5% 

dengan data responden berjumlah minimal 30).. 

 

 

 



 

 Praktikum 10. Uji Kolinearitas/Multikolienaritas  

 

A. Tujuan Praktikum 

Melihat ada tidaknya hubungan yang sangat kuat/sempurna antar 

variabel bebas (X) melalui uji kolinearitas/multikolienaritas. 

Keterangan : istilah kolinearitas dipakai jika hanya ada dua variabel 

bebas, sedangkan multkolinearitas digunakan jika jumlah variabel 

bebasnya lebih dari dua. 

 

B. Masalah Penelitian Pendidikan 

1. Apakah hubungan yang kuat antara variabel motivasi belajar 

dengan kemampuan awal? 

2. Apakah hubungan yang kuat antara variabel uang saku dengan 

motivasi belajar? 

 

C. Kasus 

Berikut ini disajikan data motivasi belajar, kemampuan awal, dan 

prestasi belajar IPA SMP kelas VIII. 

Motivasi 
Belajar 

Kemampuan 
Awal 

Prsetasi 
Belajar  

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 



 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Berdasarkan data di atas ujilah : 

1. Ujilah apakah hubungan antara variabel kemampuan awal dengan 

variabel prestasi belajar berbentuk linear? 

2. Ujilah apakah hubungan antara variabel motivasi belajar dengan 

variabel prestasi belajar berbentuk linear? 

Gunakan taraf signifikansi 5 %. 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” untuk variabel motivasi belajar di 

baris pertama dengan decimals bernilai 2, “Awal” untuk variabel 

kemampuan awal di baris ke dua dengan decimals bernilai 2, dan 

“Akhir” untuk variabel prestasi belajar di baris ke tiga dengan 

decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, kemampuan 

awal, dan kemampuan akhir sebagai berikut. 



 

 
 

4. Uji yang dapat digunakan : (a) uji korelasi Product Moment (uji ini 

dapat dipakai jika hanya ada dua variabel bebas), dan (b) Uji VIF 

(Variance Inflation Factor).  

5. Uji VIF (Variance Inflation Factor) : dilakukan dengan menggunakan 

menu Analyze → Regression → Linear. 

6. Masukkan variabel Akhir ke kotak Dependent dan variabel Motivasi 

dan Awal ke dalam kotak Independent(s). 



 

 
 

7. Klik tombol Statistics... → klik Colinearity Diagnostics → klik 

Continue. 

 
8. Klik OK sehingga akan muncul hasil analisis sebagai berikut. 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Awal, Motivasib . Enter 

a. Dependent Variable: Akhir 

b. All requested variables entered. 

 

 



 

 

Model Summary 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .820a .672 .648 4.88516 

a. Predictors: (Constant), Awal, Motivasi 

 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1319.817 2 659.909 27.652 .000b 

Residual 644.349 27 23.865   

Total 1964.167 29    

a. Dependent Variable: Akhir 

b. Predictors: (Constant), Awal, Motivasi 

 

Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. 

Collinearity 

Statistics 

B Std. Error Beta Tolerance VIF 

1 (Constant) 32.230 8.484  3.799 .001   

Motivasi .285 .248 .290 1.146 .262 .189 5.278 

Awal .946 .436 .549 2.166 .039 .189 5.278 

a. Dependent Variable: Akhir 

 

Collinearity Diagnosticsa 

Model Dimension Eigenvalue Condition Index 

Variance Proportions 

(Constant) Motivasi Awal 

1 1 2.975 1.000 .00 .00 .00 

2 .023 11.405 .26 .00 .18 

3 .002 37.981 .74 1.00 .82 

a. Dependent Variable: Akhir 

 

 

E. Pembacaan Hasil Analisis 

Untuk kepentingan uji multikolinearitas yang perlu ditafsirkan hanyalah 

Tabel Coefficients.  

Hipotesis Penelitian : 

Ho : terjadi kolinearitas antara variabel kemampuan dan motivasi 

belajar. 



 

H1 : tidak terjadi kolinearitas antara variabel uang saku dan 

motivasi belajar. 

 

Ketentuan 

Yang perlu dilihat adalah nilai tolerance  atau VIF. 
Jika tolerance > 0,10, maka Ho ditolak. 
Jika tolerance < 0,10, maka Ho diterima. 
Atau  
Jika VIF > 10, maka Ho diterima. 
Jika VIF < 10, maka Ho ditolak. 

 

Berdasarkan hasil analisis di atas menunjukkan bahwa nilai VIF yang 

ditemukan adalah sebesar 5,278 atau toleransi 0,189. Oleh karena 

nilai VIF tersebut kurang dari 10  atau toleransi lebih dari 0,10 maka 

Ho ditolak. Dengan demikian dapat disimpulkan bahwa tidak terjadi 

kolinearitas antara variabel kemampuan awal dan motivasi belajar. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan Analisis uji 

kolinearitas/Multikolienaritas untuk mengetahu terjadi  kolinearitas  

antar variabel bebas atau tidak (gunakan taraf signifikansi 5% dengan 

data responden berjumlah minimal 30). 

 

  



 

Praktikum 11. Uji Otokorelasi 

 

 

A. Tujuan Praktikum 

Mendeteksi keberadaan autokorelasi (hubungan antara nilai-nilai 

error dengan waktu tertentu) dalam residual (kesalahan prediksi) 

dari analisis regresi atau dengan kata lain mendeteksi hubungan 

antara error periode yang satu dengan error periode lainnya.  

Keterangan : 

Dalam analisis regresi error haruslah bersifat independen dari error 

lainnya, artinya error dari pengamatan yang satu bukanlah 

merupakan akibat dari error pengamatan yang lain. Uji Otokorelasi 

khusus untuk data yang sifatnya time series. Prasyarat ini harus 

dipenuhi sebelum dilakukan Uji Otokorelasi. 

 

B. Masalah Penelitian Pendidikan 

Apakah terjadi otokorelasi untuk regresi variabel prestasi belajar 

atas variabel uang saku dan motivasi belajar? 

 

C. Kasus 

Berikut ini disajikan data uang saku, motivasi belajar, dan prestasi 

belajar IPA SMP kelas VIII. 

Uang Saku 
(Ribu per hari) 

Kemampuan 
Awal 

Prsetasi 
Belajar  

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 



 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 

 

Berdasarkan data di atas ujilah, ujilah apakah terjadi otokorelasi 

untuk regresi variabel prestasi belajar atas variabel uang saku dan 

motivasi belajar? 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian 

bawah. 

2. Isikan di kolom Name “UangSaku” untuk variabel uang saku di 

baris pertama dengan decimals bernilai 2, “Motivasi” untuk 

variabel motivasi belajar di baris ke dua dengan decimals bernilai 

2, dan “Prestasi” untuk variabel prestasi belajar di baris ke tiga 

dengan decimals bernilai 2.  

 
 



 

3. Pilih Data View dan masukan nilai uang saku, motivasi belajar, 

dan prestasi sebagai berikut. 

 
 

4. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

5. Masukkan variabel Prestasi ke kotak Dependent dan variabel 

UangSaku dan Motivasi ke dalam kotak Independent(s) 

sehingga akan terlihat seperti berikut. 



 

 
 

6. Klik tombol Statistics → Durbin Watson Test →  Continue. 

 
7. Klik OK sehingga akan muncul hasil analisis SPSS sebagai 

berikut. 

 Variables Entered/Removeda 



 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Motivasi, 

UangSakub 
. Enter 

a. Dependent Variable: Prestasi 

b. All requested variables entered. 

Model Summaryb 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate Durbin-Watson 

1 .820a .672 .648 4.88516 .780 

a. Predictors: (Constant), Motivasi, UangSaku 

b. Dependent Variable: Prestasi 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1319.817 2 659.909 27.652 .000b 

Residual 644.349 27 23.865   

Total 1964.167 29    

a. Dependent Variable: Prestasi 

b. Predictors: (Constant), Motivasi, UangSaku 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 32.230 8.484  3.799 .001 

UangSaku .285 .248 .290 1.146 .262 

Motivasi .946 .436 .549 2.166 .039 

a. Dependent Variable: Prestasi 

Residuals Statisticsa 

 Minimum Maximum Mean Std. Deviation N 

Predicted Value 62.3453 86.1928 70.8333 6.74618 30 

Residual -15.52450 6.42469 .00000 4.71370 30 

Std. Predicted Value -1.258 2.277 .000 1.000 30 

Std. Residual -3.178 1.315 .000 .965 30 

a. Dependent Variable: Prestasi 

 

E. Pembacaan Hasil Analisis 

Hasil analisis yang dihasilkan dari analisis SPSS ini sebenarnya 

cukup banyak dan sama dengan yang dihasilkan dari analisis 

regresi ganda namun untuk kepentingan uji otokorelasi yang perlu 

ditafsirkan hanyalah tabel Model Summary.  



 

Hipotesis Penelitian : 

Ho : tidak terdapat autokorelasi positif dalam model regresi. 

 

Pedoman penolakan Ho adalah : 

Hipotesis Keputusan Jika 

Tidak ada autokorelasi 
positif 

Tolak 0 < d < dl 

Tidak ada autokorelasi 
positif 

Tidak ada 
keputusan 

dl ≤ d ≤ du 

Tidak ada autokorelasi 
positif atau negatif 

Tidak ditolak du < d <4 - du 

Tidak ada autokorelasi 
negatif 

Tidak ada 
keputusan 

4 – du < d < 4 - dl 

Tidak ada autokorelasi 
negatif 

Tolak 4 – dl < d < 4 

 
Nilai  DW  adalah  sebesar  0,780.  Nilai  DW  hitung  ini  kemudian  

akan dibandingkan dengan DW Tabel. Dengan signifikansi 5%, 

jumlah sampel 30, dan  jumlah  variabel  independen  adalah  2,  

maka  diperoleh  DW  hitung sebesar dl 1,284 dan du 1,567. 

 

dl 1,284 

du 1,567 

4 – dl 2,716 

4 - du 2,433 
 

Karena DW hitung lebih kecil dibanding dl atau 0 < d < dl, maka 

dapat dinyatakan bahwa ada autokorelasi positif. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang 

dilengkapi data (data fiktif tidak masalah) dan lakukan Analisis uji 



 

autokorelasi untuk mendeteksi keberadaan autokorelasi 

(hubungan antara nilai-nilai error dengan waktu tertentu) dalam 

residual (kesalahan prediksi) dari analisis regresi (gunakan taraf 

signifikansi 5% dengan data responden berjumlah minimal 30). 

  



 

 

 

 

 

 

 

BAB V.  

UJI HOMOSEDASTISITAS 

 

 

 

 

 

 

 
  



 

Praktikum 12. Uji Park 

 

 

A. Tujuan Praktikum 

Menguji error atau galat dalam model statistik untuk melihat apakah 

varians atau keragaman dari error terpengaruh oleh faktor lain atau 

tidak dengan uji homosedastisitas metode uji Park. 

Homosedastisitas adalah kondisi dalam mana varians dari data 

adalah sama pada seluruh pengamatan. Uji homosedastisitas 

digunakan sebagai prasyarat uji regresi. 

 

B. Masalah Penelitian Pendidikan 

Apakah error yang dihasilkan dari sebuah persamaan garis regresi Y 

atas X1 dan X2 memiliki varians yang homogen? 

 

C. Kasus 

Berikut ini disajikan data motivasi belajar, kemampuan awal, dan 

prestasi belajar IPA SMP kelas VIII. 

Motivasi 
Belajar 

Kemampuan 
Awal 

Prsetasi 
Belajar  

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 



 

64 22 69 

66 20 70 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Berdasarkan data di atas ujilah, ujilah apakah varians error yang 

dihasilkan dari persamaan regresi variabel prestasi belajar atas 

kemampuan awal dan motivasi belajar bersifat homogen? Gunakan 

taraf signifikansi 5%! 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” untuk variabel motivasi belajar di 

baris pertama dengan decimals bernilai 2, “Awal” untuk variabel 

kemampuan awal di baris ke dua dengan decimals bernilai 2, dan 

“Akhir” untuk variabel prestasi belajar di baris ke tiga dengan 

decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, kemampuan 

awal, dan kemampuan akhir sebagai berikut. 



 

 
 

4. Menyimpan nilai residual/error ke dalam data dengan cara: 

a. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

b. Masukkan variabel Akhir ke kotak Dependent dan variabel 

Motivasi dan Awal ke dalam kotak Independent(s). 



 

 
 

c. Klik tombol Save → klik Unstandardized pada kotak Residuals 

→ klik Continue. 



 

 
 

d. Klik OK sehingga akan muncul hasil analisis regresi seperti 

biasa. Namun demikian hasil analisis ini tidak dipakai untuk 

keperluan uji homosedastisitas, tetapi analisis ini hanya ingin 

menambahkan nilai residual/error pada data. 

Lihat pada data view akan ada tambahan satu variabel lagi 

berupa res_1 seperti terlihat pada gambar berikut ini. 



 

 
 

5. Mengabsolutkan nilai error/residual, dengan langkah-langkah 

sebagai  berikut. 

a. Klik menu Transform → Compute Variable. 

b. Ketik abs_res pada kota Target variable. Penulisan ini tidaklah 

mutlak artinya tidak harus abs_res tetapi bisa apa saja asal 

memenuhi ketentuan dalam penulian nama variabel. 

c. Ketik abs(res_1) pada kotak Numeric Expression. Penulisan abs 

ini sifatnya wajib karena merupakan fungsi untuk 

mengabsolutkan suatu variabel, sedangkan res_1 merupakan 

nama variabel yang akan diabsolutkan yang diletakkan di antara 

tanda kurung. 



 

d. Hasilnya akan seperti terlihat pada gambar berikut. 

 
 

e. Klik tombol Type & Label lalu di kotak Label isikan Absolut 

Residu, lalu klik tombol Continue. 

 
f. Klik OK sehingga di dalam data view akan ditambahkan satu 

variabel lagi yaitu abs_res. 



 

 
 

6. Meregresi nilai absolut error atas seluruh variabel bebas 

a. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

b. Masukkan variabel abs_res ke kotak Dependent dan variabel 

Motivasi dan Awal ke dalam kotak Independent(s) sehingga 

akan terlihat sebagai berikut. 



 

 
 

c. Klik OK sehingga keluar hasil analisis dengan SPSS sebagai 

berikut. 
 

REGRESSION 

  /MISSING LISTWISE 

  /STATISTICS COEFF OUTS R ANOVA 

  /CRITERIA=PIN(.05) POUT(.10) 

  /NOORIGIN 

  /DEPENDENT Akhir 

  /METHOD=ENTER Motivasi Awal 

  /SAVE RESID. 

 

Regression 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Awal, Motivasib . Enter 

a. Dependent Variable: Akhir 

b. All requested variables entered. 

Model Summaryb 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .820a .672 .648 4.88516 

a. Predictors: (Constant), Awal, Motivasi 

b. Dependent Variable: Akhir 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 



 

1 Regression 1319.817 2 659.909 27.652 .000b 

Residual 644.349 27 23.865   

Total 1964.167 29    

a. Dependent Variable: Akhir 

b. Predictors: (Constant), Awal, Motivasi 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 32.230 8.484  3.799 .001 

Motivasi .285 .248 .290 1.146 .262 

Awal .946 .436 .549 2.166 .039 

a. Dependent Variable: Akhir 

Residuals Statisticsa 

 Minimum Maximum Mean Std. Deviation N 

Predicted Value 62.3453 86.1928 70.8333 6.74618 30 

Residual -15.52450 6.42469 .00000 4.71370 30 

Std. Predicted Value -1.258 2.277 .000 1.000 30 

Std. Residual -3.178 1.315 .000 .965 30 

a. Dependent Variable: Akhir 
 

COMPUTE abs_res=abs(res_1). 

VARIABLE LABELS  abs_res 'Absolute Residu'. 

EXECUTE. 

REGRESSION 

  /MISSING LISTWISE 

  /STATISTICS COEFF OUTS R ANOVA 

  /CRITERIA=PIN(.05) POUT(.10) 

  /NOORIGIN 

  /DEPENDENT abs_res 

  /METHOD=ENTER Motivasi Awal. 

 
Regression 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Awal, Motivasib . Enter 

a. Dependent Variable: Absolute Residu 

b. All requested variables entered. 

Model Summary 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .159a .025 -.047 3.18476 

a. Predictors: (Constant), Awal, Motivasi 



 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 7.090 2 3.545 .350 .708b 

Residual 273.853 27 10.143   

Total 280.943 29    

a. Dependent Variable: Absolute Residu 

b. Predictors: (Constant), Awal, Motivasi 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) .902 5.531  .163 .872 

Motivasi .012 .162 .032 .073 .943 

Awal .085 .285 .130 .297 .769 

a. Dependent Variable: Absolute Residu 

 

E. Pembacaan Hasil Analisis 

Hasil analisis yang dihasilkan dari analisis SPSS ini sebenarnya cukup 

banyak dan sama dengan yang dihasilkan dari analisis regresi ganda 

namun untuk kepentingan uji multikolinearitas yang perlu ditafsirkan 

hanyalah tabel ANOVA dan Coefficients.  

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 7.090 2 3.545 .350 .708b 

Residual 273.853 27 10.143   

Total 280.943 29    

a. Dependent Variable: Absolute Residu 

b. Predictors: (Constant), Awal, Motivasi 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

T Sig. B Std. Error Beta 

1 (Constant) .902 5.531  .163 .872 

Motivasi .012 .162 .032 .073 .943 

Awal .085 .285 .130 .297 .769 

a. Dependent Variable: Absolute Residu 

 

 

 



 

Hipotesis Penelitian Pertama : 

Ho : terjadinya heterosedastisitas untuk variable motivasi. 

H1 : tidak terjadinya heterosedastisitas untuk variable motivasi. 

 

Hipotesis Penelitian Kedua : 

Ho : terjadinya heterosedastisitas untuk kemampuan awal. 

H1 : tidak terjadinya heterosedastisitas untuk kemampuan awal. 

 

Ketentuan 
Yang perlu dilihat adalah hasil pengujian F regresinya. 
Jika F signifikan atau sig F ≥ 0,05, maka Ho ditolak. 
Jika F signifikan atau sig F < 0,05, maka Ho diterima. 

 

Berdasarkan hasil analisis di atas menunjukkan bahwa nilai F yang 

ditemukan sebesar 0,350 dengan sig 0,708. Oleh karena nilai sig 

tersebut lebih besar dari 0,05 maka Ho ditolak. Dengan demikian dapat 

disimpulkan tidak terjadi heterosedastisitas atau terjadi 

homosedastisitas. Dengan demikian persyaratan analisis regresi 

terpenuhi. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang dilengkapi 

data (data fiktif tidak masalah) dan lakukan Analisis uji 

homosedastisitas dengan metode uji Park untuk mengetahui 

persyaratan terjadinya homosedastisitas dalam persamaan regresi 

terpenuhi atau tidak (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 

  



 

Praktikum 11. Uji Rho Spearman 

 

 

A. Tujuan Praktikum 

Menguji error atau galat dalam model statistik untuk melihat apakah 

varians atau keragaman dari error terpengaruh oleh faktor lain atau 

tidak dengan uji homosedastisitas dengan metode uji Rho Spearman. 

Uji homosedastisitas digunakan sebagai prasyarat uji regresi. 

 

B. Masalah Penelitian Pendidikan 

Apakah error yang dihasilkan dari sebuah persamaan garis regresi Y 

atas X1 dan X2 memiliki varians yang homogen? 

 

C. Kasus 

Berikut ini disajikan data motivasi belajar, kemampuan awal, dan 

prestasi belajar IPA SMP kelas VIII. 

Motivasi 
Belajar 

Kemampuan 
Awal 

Prsetasi 
Belajar  

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 



 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Berdasarkan data di atas ujilah, ujilah apakah varians error yang 

dihasilkan dari persamaan regresi variabel prestasi belajar atas 

kemampuan awal dan motivasi belajar bersifat homogen? Gunakan 

taraf signifikansi 5%! 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” untuk variabel motivasi belajar di 

baris pertama dengan decimals bernilai 2, “Awal” untuk variabel 

kemampuan awal di baris ke dua dengan decimals bernilai 2, dan 

“Akhir” untuk variabel prestasi belajar di baris ke tiga dengan 

decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, kemampuan 

awal, dan kemampuan akhir sebagai berikut. 



 

 
 

4. Menyimpan nilai residual/error ke dalam data dengan cara: 

a. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

b. Masukkan variabel Akhir ke kotak Dependent dan variabel 

Motivasi dan Awal ke dalam kotak Independent(s). 



 

 
 

c. Klik tombol Save → klik Unstandardized pada kotak Residuals 

→ klik Continue. 



 

 
d. Klik OK sehingga akan muncul hasil analisis regresi seperti 

biasa. Namun demikian hasil analisis ini tidak dipakai untuk 

keperluan uji homosedastisitas, tetapi analisis ini hanya ingin 

menambahkan nilai residual/error pada data. 

Lihat pada data view akan ada tambahan satu variabel lagi 

berupa res_1 seperti terlihat pada gambar berikut ini. 



 

 
 

5. Mengabsolutkan nilai error/residual, dengan langkah-langkah 

sebagai  berikut. 

a. Klik menu Transform → Compute Variable. 

b. Ketik abs_res pada kota Target variable. Penulisan ini tidaklah 

mutlak artinya tidak harus abs_res tetapi bisa apa saja asal 

memenuhi ketentuan dalam penulian nama variabel. 

c. Ketik abs(res_1) pada kotak Numeric Expression. Penulisan abs 

ini sifatnya wajib karena merupakan fungsi untuk 

mengabsolutkan suatu variabel, sedangkan res_1 merupakan 

nama variabel yang akan diabsolutkan yang diletakkan di antara 

tanda kurung. 



 

d. Hasilnya akan seperti terlihat pada gambar berikut. 

 
 

e. Klik tombol Type & Label lalu di kotak Label isikan Absolut 

Residu, lalu klik tombol Continue. 

 
f. Klik OK sehingga di dalam data view akan ditambahkan satu 

variabel lagi yaitu abs_res. 



 

 
 

6. Menghitung koefisien korelasi antara nilai absolut residu dengan 

seluruh variabel bebas. 

a. Lakukan analisis dengan menggunakan menu Analyze → 

Correlate → Bivariate 

b. Masukkan variabel abs_res, Motivasi dan Awal ke dalam 

kotak Variables lalu hilangkan tanda check pada bagian 

Pearson dan beri tanda check pada bagian Spearman dengan 

cara klik, sehingga akan terlihat pada gambar berikut ini. 



 

 
 

c. Klik OK sehingga akan muncul hasil analisis SPSS sebagai 

berikut. 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed 

Metho

d 

1 Awal, 

Motivasib 
. Enter 

a. Dependent Variable: Akhir 

b. All requested variables entered. 

Model Summaryb 

Model R 

R 

Square 

Adjusted R 

Square 

Std. Error of 

the 

Estimate 

1 .820a .672 .648 4.88516 

a. Predictors: (Constant), Awal, Motivasi 

b. Dependent Variable: Akhir 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1319.817 2 659.909 27.652 .000b 

Residual 644.349 27 23.865   

Total 1964.167 29    

a. Dependent Variable: Akhir 

b. Predictors: (Constant), Awal, Motivasi 



 

 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 32.230 8.484  3.799 .001 

Motivasi .285 .248 .290 1.146 .262 

Awal .946 .436 .549 2.166 .039 

a. Dependent Variable: Akhir 

Residuals Statisticsa 

 Minimum Maximum Mean Std. Deviation N 

Predicted Value 62.3453 86.1928 70.8333 6.74618 30 

Residual -15.52450 6.42469 .00000 4.71370 30 

Std. Predicted Value -1.258 2.277 .000 1.000 30 

Std. Residual -3.178 1.315 .000 .965 30 

a. Dependent Variable: Akhir 

Correlations 

 Motivasi Awal Absolute Residu 

Spearman's 

rho 

Motivasi Correlation 

Coefficient 
1.000 .872** .148 

Sig. (2-

tailed) 
. .000 .436 

N 30 30 30 

Awal Correlation 

Coefficient 
.872** 1.000 .215 

Sig. (2-

tailed) 
.000 . .254 

N 30 30 30 

Absolute Residu Correlation 

Coefficient 
.148 .215 1.000 

Sig. (2-

tailed) 
.436 .254 . 

N 30 30 30 

**. Correlation is significant at the 0.01 level (2-tailed). 

 

E. Pembacaan Hasil Analisis 

Hasil analisis yang dihasilkan dari analisis SPSS ini sebenarnya cukup 

banyak dan sama dengan yang dihasilkan dari analisis regresi ganda 

namun untuk kepentingan uji multikolinearitas yang perlu ditafsirkan 

hanyalah tabel Correlations bagian koefisien korelasi Rho antara 



 

Motivasi dengan absolut residu, dan korelasi Rho antara Awal dengan 

absolut residu.  

Correlations 

 Motivasi Awal Absolute Residu 

Spearman's rho Motivasi Correlation 

Coefficient 
1.000 .872** .148 

Sig. (2-tailed) . .000 .436 

N 30 30 30 

Awal Correlation 

Coefficient 
.872** 1.000 .215 

Sig. (2-tailed) .000 . .254 

N 30 30 30 

Absolute Residu Correlation 

Coefficient 
.148 .215 1.000 

Sig. (2-tailed) .436 .254 . 

N 30 30 30 

**. Correlation is significant at the 0.01 level (2-tailed). 

 

Hipotesis Penelitian Pertama : 

Ho : terjadinya heterosedastisitas untuk variable motivasi  

H1 : tidak terjadinya heterosedastisitas untuk variable motivasi. 

 

Hipotesis Penelitian Kedua : 

Ho : terjadinya heterosedastisitas untuk variable kemampuan 

awal. 

H1 : tidak terjadinya heterosedastisitas untuk variable 

kemampuan awal. 

 

Ketentuan 
Jika sig (2-tailed) ≥ ½ α (0,025), maka Ho ditolak. 
Jika sig (2-tailed) < ½ α (0,025), maka Ho diterima. 

 

Berdasarkan hasil analisis di atas menunjukkan bahwa : 

a. Koefisien korelasi Rho antara Motivasi dengan Absolut Residu 

adalah sebesar 0,148 dengan sig (2-tailed) sebesar 0,436. Oleh 

karena nilai sig (2-tailed) tersebut lebih besar dari 0,025 maka Ho di 

tolak. Dengan demikian tidak terjadi heterosedastisitas untuk 

motivasi belajar. 

b. Koefisien korelasi Rho antara Awal dengan Absolut Residu adalah 

sebesar 0,215 dengan sig (2-tailed)  sebesar 0,254. Oleh karena 



 

nilai sig (2-tailed) tersebut lebih besar dari 0,025 maka Ho ditolak. 

Dengan demikian tidak terjadi heterosedastisitas untuk variabel 

kemampuan awal. 

c. Dengan demikian persyaratan terjadinya homosedastisitas dalam 

persamaan regresi tersebut terpenuhi. 

 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang dilengkapi 

data (data fiktif tidak masalah) dan lakukan Analisis uji 

homosedastisitas dengan metode uji Rho untuk mengetahui 

persyaratan terjadinya homosedastisitas dalam persamaan regresi 

terpenuhi atau tidak (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 

  



 

Praktikum 14. Uji Glejser 

 

 

A. Tujuan Praktikum 

Menguji error atau galat dalam model statistik untuk melihat apakah 

varians atau keragaman dari error terpengaruh oleh faktor lain atau 

tidak dengan uji homosedastisitas metode uji Glejser. 

Uji homosedastisitas digunakan sebagai prasyarat uji regresi. 

 

B. Masalah Penelitian Pendidikan 

Apakah error yang dihasilkan dari sebuah persamaan garis regresi Y 

atas X1 dan X2 memiliki varians yang homogen? 

 

C. Kasus 

Berikut ini disajikan data motivasi belajar, kemampuan awal, dan 

prestasi belajar IPA SMP kelas VIII. 

Motivasi 
Belajar 

Kemampuan 
Awal 

Prsetasi 
Belajar  

78 30 89 

69 21 76 

56 15 65 

50 17 66 

55 18 68 

60 19 69 

80 33 90 

65 20 68 

66 21 70 

60 20 70 

73 23 72 

57 19 67 

59 18 68 

63 22 71 

79 32 90 

68 22 78 

58 18 68 

52 18 67 

57 16 70 

59 18 65 

82 32 86 

64 22 69 

66 20 70 



 

63 24 68 

74 25 70 

58 18 65 

56 20 64 

65 22 56 

61 19 60 

64 26 70 
 

Berdasarkan data di atas ujilah, ujilah apakah varians error yang 

dihasilkan dari persamaan regresi variabel prestasi belajar atas 

kemampuan awal dan motivasi belajar bersifat homogen? Gunakan 

taraf signifikansi 5%! 

 

D. Prosedur Analisis 

1. Jalankan program SPSS 22, pilih Variable View di bagian bawah. 

2. Isikan di kolom Name “Motivasi” untuk variabel motivasi belajar di 

baris pertama dengan decimals bernilai 2, “Awal” untuk variabel 

kemampuan awal di baris ke dua dengan decimals bernilai 2, dan 

“Akhir” untuk variabel prestasi belajar di baris ke tiga dengan 

decimals bernilai 2.  

 
 

3. Pilih Data View dan masukan nilai motivasi belajar, kemampuan 

awal, dan kemampuan akhir sebagai berikut. 



 

 
 

4. Menyimpan nilai residual/error ke dalam data dengan cara: 

a. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

b. Masukkan variabel Akhir ke kotak Dependent dan variabel 

Motivasi dan Awal ke dalam kotak Independent(s). 



 

 
 

c. Klik tombol Save → klik Unstandardized pada kotak Residuals 

→ klik Continue. 



 

 
 

d. Klik OK sehingga akan muncul hasil analisis regresi seperti 

biasa. Namun demikian hasil analisis ini tidak dipakai untuk 

keperluan uji homosedastisitas, tetapi analisis ini hanya ingin 

menambahkan nilai residual/error pada data. 

Lihat pada data view akan ada tambahan satu variabel lagi 

berupa res_1 seperti terlihat pada gambar berikut ini. 



 

 
 

5. Mengkuadratkan nilai residu/error, dengan langkah-langkah 

sebagai  berikut. 

a. Klik menu Transform → Compute 

b. Ketik sqr_res pada kota Target variable. Penulisan ini tidaklah 

mutlak artinya tidak harus sqr_res tetapi bisa apa saja asal 

memenuhi ketentuan dalam penulian nama variabel. 

c. Ketik res_1**2 pada kotak Numeric Expression. Penulisan ini 

sifatnya wajib karena lambang ** dalam SPSS berarti pangkat, 

sedangkan res_1 merupakan nama variabel yang akan 

dikuadratkan. 

d. Hasilnya akan seperti terlihat pada gambar berikut. 



 

 
6. Meregresi nilai absolut error atas seluruh variabel bebas 

d. Lakukan analisis dengan menggunakan menu Analyze → 

Regression → Linear. 

e. Masukkan variabel abs_res ke kotak Dependent dan variabel 

Motivasi dan Awal ke dalam kotak Independent(s) sehingga 

akan terlihat sebagai berikut. 



 

 
 

f. Klik OK sehingga keluar hasil analisis dengan SPSS sebagai 

berikut. 

Variables Entered/Removeda 

Model 

Variables 

Entered 

Variables 

Removed Method 

1 Awal, Motivasib . Enter 

a. Dependent Variable: Absolute Residu 

b. All requested variables entered. 

 

Model Summary 

Model R R Square 

Adjusted R 

Square 

Std. Error of the 

Estimate 

1 .159a .025 -.047 3.18476 

a. Predictors: (Constant), Awal, Motivasi 

 

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 7.090 2 3.545 .350 .708b 

Residual 273.853 27 10.143   

Total 280.943 29    

a. Dependent Variable: Absolute Residu 

b. Predictors: (Constant), Awal, Motivasi 



 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) .902 5.531  .163 .872 

Motivasi .012 .162 .032 .073 .943 

Awal .085 .285 .130 .297 .769 

a. Dependent Variable: Absolute Residu 

 

E. Pembacaan Hasil Analisis 

Hasil analisis yang dihasilkan dari analisis SPSS ini sebenarnya cukup 

banyak namun untuk kepentingan uji homosedastisitas yang perlu 

ditafsirkan hanyalah tabel Coefficients.  

Hipotesis Penelitian Pertama : 

Ho : terjadinya heterosedastisitas untuk variable motivasi. 

H1 : tidak terjadinya heterosedastisitas untuk variable motivasi. 

Hipotesis Penelitian Kedua : 

Ho : terjadinya heterosedastisitas untuk variable kemampuan 

awal. 

H1 : tidak terjadinya heterosedastisitas untuk variable 

kemampuan awal. 

Ketentuan 
Yang perlu dilihat adalah hasil pengujian F regresinya. 
Jika sig F ≥ 0,05, maka Ho ditolak. 
Jika sig F < 0,05, maka Ho diterima. 

 

Berdasarkan hasil analisis di atas menunjukkan bahwa : 

a. Variabel Motivasi dengan nilai sig sebesar 0,948. Oleh karena nilai 

sig tersebut lebih besar dari 0,05 maka Ho di tolak. Dengan 

demikian tidak terjadi heterosedastisitas untuk motivasi belajar. 

b. Variabel Awal dengan dengan nilai sig sebesar 0,769. Oleh karena 

nilai sig tersebut lebih besar dari 0,05 maka Ho ditolak. Dengan 

demikian tidak terjadi heterosedastisitas untuk variabel 

kemampuan awal. 

c. Dengan demikian persyaratan terjadinya homosedastisitas dalam 

persamaan regresi tersebut terpenuhi. 

 

 

 

 



 

F. Tugas 

Buatlah satu persoalan/kasus dalam dunia pendidikan yang dilengkapi 

data (data fiktif tidak masalah) dan lakukan Analisis uji 

homosedastisitas dengan metode uji Glejser untuk mengetahui 

persyaratan terjadinya homosedastisitas dalam persamaan regresi 

terpenuhi atau tidak (gunakan taraf signifikansi 5% dengan data 

responden berjumlah minimal 30). 
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Lampiran 

Durbin Watson Test Values: 

 

 Table B-4:  critical values for one-sided test at 5% significance (or 
2-sided test at 10%). 

 

 Table B-5:  critical values for one-sided test at 2.5% significance (or 
2-sided test at 5%). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 



 

 

 
 

 

 


